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Safety notices

A CAUTION notice denotes a hazard.
It calls attention to an operating
procedure, practice, or the like that, if
not correctly performed or adhered to,
could result in damage to the product
or loss of important data. Do not
proceed beyond a CAUTION notice
until the indicated conditions are fully
understood and met.

A WARNING notice denotes a
hazard. It calls attention to an
operating procedure, practice, or the
like that, if not correctly performed or
adhered to, could result in personal
injury or death. Do not proceed
beyond a WARNING notice until the
indicated conditions are fully
understood and met.
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General

Your Agilent AA instrument and accessories have been carefully
designed so that when used properly you have an accurate, fast,
flexible and safe analytical system.

If the equipment is used in a manner not specified by the
manufacturer, the protection provided by the equipment may be
impaired.
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Operation of an atomic absorption spectrometer can involve the use
of compressed gases, flames, and hazardous materials including
corrosive fluids and flammable liquids. Unskilled, improper, or
careless use of this instrument can create explosion hazards, fire
hazards, or other hazards that can cause death, serious injury to
personnel, or severe damage to equipment and property.

Information on safety practices is provided with your instrument and
operation manuals, and also referenced in your Agilent accessory
manuals. Thoroughly read these safety practices before using your
instrument or accessories.

Observe all relevant safety practices always.

The safety practices described below are provided to help you
operate the instrument safely. Read each safety topic thoroughly
before attempting to operate the instrument and always operate the
spectrometer in accordance with these safety practices. Only trained
operators should use this instrument.

Verifying safe state

The following general safety precautions must be observed during all
phases of operation, maintenance and service of this instrument.

To ensure continued safety of the instrument after maintenance or
service procedures verify the instrument is returned to a safe state
for the user. This includes running performance checks to verify the
instruments safety systems are functioning correctly. Check the
general condition of the instrument during operation for wear or
signs of corrosion that are likely to inhibit function or safety.

Failure to comply with these precautions or with specific warnings
elsewhere in this manual violates safety standards of design,
manufacture, and intended use of the instrument. Agilent
Technologies assumes no liability for the customer’s failure to
comply with these requirements.

Agilent 240/280 Series AA User’'s Guide
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Electrical hazards

The instrument and accessories contain electrical circuits, devices,
and components operating at dangerous voltages. Contact with these
circuits, devices and components can cause death, serious injury, or
painful electric shock.

Panels and covers that are retained by fasteners which require the
use of a tool for removal must only be opened by Agilent field service
engineers. Consult the manuals or product labels supplied with your
PC, monitor, printer/plotter, water-cooling system, and vacuum
pump (where required) to determine which parts are operator-
accessible.

Application of the wrong supply voltage, connection of the
instrument to an incorrectly wired supply outlet, or lack of proper
electrical grounding can create a fire hazard or a potentially serious
shock hazard. This could seriously damage the instrument and any
attached ancillary equipment.

Always use a 3-wire outlet with ground connection that is adequately
rated for the load. The installation must comply with local and
national safety regulations. Use only an Agilent supplied power cord.
Replace the power cord only with a cord equivalent to the one
specified in the AA Site Preparation Guide.

Do not connect the instrument to the mains power supply until you
have made sure that the operating voltage is correctly set for the
mains power supply in the specific outlet in your laboratory to which
the equipment is connected.

m Electrical shock hazard

To avoid electric shock this equipment must be disconnected from the mains
supply before servicing.

Agilent 240/280 Series AA User's Guide 11
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Heat, vapors and fumes

Heat, vapors and fumes generated by flame, furnace and vapor
generation methods can be hazardous to personnel.

Heat, vapors and fumes must be extracted from the instrument by an
exhaust system. The instrument must be vented into a self-contained
arrangement of collector hood, ducting, and exhaust fan. The system
must be vented to the outside air, never within the building. Locate
the system outlet such that the exhaust cannot re-enter the building
through any door, window, air conditioning inlet, or other ventilator.
Construct the system in accordance with local codes and regulations
for ventilation.

The exhaust system must provide an exhaust ventilation rate of at
least 6 cubic meters per minute (200 cfm). Locate the exhaust fan at
least 3 meters (10 feet) away from the flame and as close to the outlet
as possible. The motor must be mounted away from the hot gases,
and plastic parts must not be used as they will melt. Fit a back-draft
damper to the outlet end of the system. Equip the exhaust fan power
supply with an indicator close to the instrument to indicate whether
the exhaust fan is on or off. Always switch on the exhaust fan before
lighting the flame.

Use fireproof ducting that is in accordance with your local fire
prevention regulations. Locate the ducting away from fire alarms,
sprinkler heads, and other heat-sensitive devices. Do not make solder
joints in the ducting—the hot exhaust in the duct may melt the joint.

Regularly check the system by smoke test to ensure that the exhaust
system is working.

When operating the atomic absorption spectrometer, always have the
chimney in place to ensure correct ventilation.

12 Agilent 240/280 Series AA User's Guide
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Compressed gases and cylinders

All compressed gases (other than air) can create a hazard if they leak
into the atmosphere. Even small leaks in gas supply systems can be
dangerous. Any leak (except that of air) can create an explosion
hazard, a fire hazard, or result in an oxygen—-deficient atmosphere.
Such hazards can cause death, serious injury, asphyxiation,
anesthetic effects, and serious damage to equipment and property.

Cylinders must be stored and handled strictly in accordance with
local safety codes and regulations. Cylinders must be used and stored
only in a vertical position. Secure all cylinders to an immovable
structure or a properly constructed cylinder stand. The area in which
cylinders are stored must be adequately ventilated to prevent toxic or
explosive accumulations. Move cylinders only on a properly
constructed trolley. Never locate gas cylinders near a source of
ignition or in a position that is subject to direct heat.

Keep cylinders cool. This rule applies to every cylinder of
compressed gas. Cylinders have pressure relief devices that release
the contents of the cylinder if the temperature exceeds 52 °C

(125 °F).

Ensure that all cylinders are clearly labeled so that there can be no
doubt about the contents. If the cylinder label is not legible, do not
use the cylinder—return it to your supplier. Always ensure that you
have the right cylinder before connecting the cylinder to the
instrument.

If air is supplied from a compressor, all moisture must be extracted
from the air before it is supplied to the gas control module. Moisture
can affect the internal components of the gas control system and
create a potentially hazardous situation.

Use only approved regulators and hose connectors.
Never attempt to refill cylinders.

Remember that for cylinder connections, left-hand thread fittings are
used for fuel; right-hand thread fittings are used for support gases.

When your analytical program is complete, or at the end of the
working day, always ensure that all gas supplies are turned off at the
cylinders.

Agilent 240/280 Series AA User's Guide 13
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Gas hoses and connections

Even small leaks in gas supply systems can be dangerous. Any leak
can create an explosion hazard, a fire hazard, or can result in an
oxygen-deficient atmosphere. Such hazards can cause death, serious
injury, asphyxiation, anesthetic effects, and serious damage to
equipment and property.

Use only approved regulators, connectors, and fittings. If in any
doubt, consult your local gas supplier or your Agilent representative.
Ensure that all gas connectors and hoses are correctly assembled.

Arrange gas hoses so that they will not be damaged, stepped on, or
have things dropped on them.

Never use frayed or damaged hoses.

Perform leak tests at all joints and seals every day before the
instrument is used. Test for leaks with a brush and soapy water or a
proprietary leak-detecting solution. Never use a naked flame when
testing for leaks.

Ultraviolet radiation

Other

Flames, hollow cathode lamps, and deuterium lamps emit hazardous
ultraviolet radiation. This radiation can cause serious damage to
human eyes and skin.

Always wear safety glasses conforming to an approved standard, and
certified or otherwise warranted to protect the eyes from ultraviolet
radiation. Never look directly at the light emitted by a hollow cathode
lamp.

When using a flame, always operate your spectrometer with the
flame shield closed, and the sample compartment front panel and
chimney in place.

Other messages appear in the manual and in the online Help where
appropriate, and detail advice, information specific to the topic, or
helpful tips.

A 'Note’ message is used to give advice or information.

14
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Warning symbols

The following is a list of symbols that appear in conjunction with
warnings in this manual and on the spectrometer. The hazard they
describe is also shown. A warning icon indicates the beginning of the
warning text:

A triangular symbol indicates a warning. The meanings of the
symbols that appear alongside warnings in the documentation or on

the instrument itself are as follows:

>

—
=
Corrosive liquids Electrical shock Explosion hazard
Eye hazard Fire hazard Heavy weight

(danger to feet)

>
P>

Heavy weight Hot surface Magnetic field

(danger to hands)

g part Noxious gases Sharp object

[>
P>

=<
S
N
S]

L2
o)

Toxic material

Read all warnings and cautions carefully and observe them always.
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Safety Practices and Hazards

The following symbol may be used on warning labels attached to the
instrument. When you see this symbol, refer to the relevant operation
or service manual for the correct procedure referred to by that

warning label.

The following symbols appear on the instrument for your

information.

Mains power on

Mains power off

Fuse

Single phase alternating current

Flame off

Flame on

Indicates lamp present

=
~_
[
b
1®
—

0
N

ED:

Disconnect all power plugs.

AIE A

Caution, disconnect all supplies, risk of electric shock

Color coding

The various indicator lights appearing on Agilent instruments and
associated accessories are color coded to represent the status of the
instrument or accessory.

16
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e A green light indicates that the instrument is in normal/standby
mode.

¢ An orange light indicates that a potential hazard is present.
¢ A blue light indicates that operator intervention is required.

e A red light warns of danger or an emergency.

CE compliance

Your Agilent AA instrument has been designed to comply with the
requirements of the Electromagnetic Compatibility (EMC) Directive
and the Low Voltage (electrical safety) Directive (commonly referred
to as the LVD) of the European Union. Agilent has confirmed that
each product complies with the relevant Directives by testing a
prototype against the prescribed EN (European Norm) standards.

Proof that a product complies with these directives is indicated by:
e The CE Marking appearing on the rear of the product, and

¢ The documentation package that accompanies the product
containing a copy of the Declaration of Conformity. The
Declaration of Conformity is the legal declaration by Agilent that
the product complies with the directives listed above, and shows
the EN standards to which the product was tested to
demonstrate compliance.

Electromagnetic compatibility

EN55011/CISPR11

Group 1 ISM equipment: group 1 contains all ISM equipment in
which there is intentionally generated and/or used conductively
coupled radio- frequency energy that is necessary for the internal
functioning of the equipment itself.

Class A equipment is equipment suitable for use in all
establishments other than domestic and those directly connected to a
low voltage power supply network that supplies buildings used for
domestic purposes.

Agilent 240/280 Series AA User's Guide 17
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This device complies with the requirements of CISPR11, Group 1,

Class A as radiation professional equipment. Therefore, there may be

potential difficulties in ensuring electromagnetic compatibility in

other environments, due to conducted as well as radiated

disturbances.

Operation is subject to the following two conditions:

1 This device may not cause harmful interference.

2 This device must accept any interference received, including
interference that may cause undesired operation.

If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the
equipment off and on, the user is encouraged to try one or more of
the following measures:

1 Relocate the radio or antenna.
2 Move the device away from the radio or television.

3 Plug the device into a different electrical outlet, so that the device
and the radio or television are on separate electrical circuits.

Make sure that all peripheral devices are also certified.

5 Make sure that appropriate cables are used to connect the device
to peripheral equipment.

6 Consult your equipment dealer, Agilent Technologies, or an
experienced technician for assistance.

Changes or modifications not expressly approved by Agilent
Technologies could void the user’s authority to operate the
equipment.

ICES/NMB-001
This ISM device complies with Canadian ICES- 001.

Cet appareil ISM est conforme & la norme NMB-001 du Canada.

Agilent 240/280 Series AA User’'s Guide
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Flame operation

Flammable solvents

Unskilled, improper, or careless use of flammable solvents in or near
an atomic absorption spectrometer can create explosion hazards and
fire hazards. This can result in death, or severe personal injury or
burns.

Remember always that the combination of a flame and flammable
solvents can present a serious hazard. All relevant safety practices
governing the use of flammable solvents must be strictly followed.

To reduce the possibility of fire or explosion:

¢ When initially selecting an organic solvent, choose a solvent
having the highest flash point consistent with your analytical
requirements.

* Never use a solvent having a specific gravity lower than 0.75.

e Never leave uncovered containers of flammable solvent standing
near the burner. When aspirating such solvents, always use a
covered container and feed the capillary tubing through a 2-mm
diameter hole in the cover. Always use the smallest volume of
solvent consistent with your analytical requirements.

¢ Always use solvent-resistant tubing such as nitrile rubber for the
drainage system and the vapor vent. Lead the drainage tube to a
suitable wide-necked waste vessel (as described in the next
paragraph). The standard plastic laboratory tubing supplied with
your instrument is not suitable for draining organic solvents or
venting organic vapors. If organic or toxic solutions are being
used in the spray chamber, vent tubing must be connected to the
vapor vent on the liquid trap, run parallel to the drain tubing,
and led to an active exhaust system. Do not lead the vapor tubing
to the waste vessel. If you are not using toxic or hazardous
liquids in the spray chamber, leave the vapor vent uncovered.

Agilent 240/280 Series AA User's Guide 19
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e Use small, wide-necked waste vessels and empty them
frequently—do not accumulate large volumes of flammable
solvent. Do not use glass waste vessels—use vessels made of a
material that will not shatter in the event of a flashback. Metal
vessels will corrode and it is difficult to determine the level of
liquid in them. Ensure that your waste vessel is below the
instrument and located in an open, well-ventilated position
where you can see it. Never locate the vessel in a confined space.

e When your analytical program has been completed, or at the end
of the working day, always empty and rinse the waste vessel.

e When your analytical program has been completed, or at the end
of the working day, always empty, clean, and refill the liquid
trap.

¢ Do not mix nitric or perchloric acid residues with organic solvent
residues.

¢ Keep the burner slot, spray chamber, and liquid trap clean.

e Always use the internal igniter to light the flame as the flame will
not operate unless all the safety interlocks are satisfied.

Exhaust
TTT system

operating

. Chimney

Burner _— Vapor vent
adiuster__' 2ol . .
«4—— Drain tubing must slope downwards

for full length with no kinks

Small, non-glass waste vessel in

A
full view of the operator \ /
Keep the end of the tube above
the highest liquid level
X

Large stable base

Wide waste vessel opening

Figure 1. System setup diagram
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Compressed gases and cylinders for flame operation

This spectrometer must only be used with air, nitrous oxide, and
acetylene for flame operation.

Never use oxygen or oxygen-enriched air as the oxidant because this
results in an explosion.

Never use any gas except acetylene as the fuel gas.

Acetylene

Unskilled, improper, or careless use of acetylene can create explosion
hazards and fire hazards that can result in death, severe personal
injury, or burns.

Use acetylene at pressures lower than 105 kPa (15 psig). At pressures
above this level, acetylene can explode spontaneously. Your Agilent
AA is designed to operate at fuel supply pressures between 65 and
100 kPa (9.5-14.5 psig). Refer to the ‘Specifications’ section or the
rear of the instrument for the exact range and recommended
pressure.

Do not use any tubing or connector that reacts chemically with
acetylene. Never pass acetylene through copper tubing, or brass
tubing or fittings containing more than 65% copper, since this may
provoke an explosion. Never bring acetylene into direct contact with
copper, silver, liquid mercury, gaseous chlorine, or grease, as an
explosion could result.

Use only acetylene that is packed in acetone. Some gas suppliers
offer acetylene packed in material other than acetone. While these
alternatives may overcome some of the disadvantages of acetone,
they may also introduce the more serious problem of corrosion in the
gas control module and must not be used with Agilent atomic
absorption spectrometers.

If the pressure in the acetylene cylinder is allowed to fall below

700 kPa (100 psig), or the consumption is greater than 1/7 of the
cylinder contents per hour, acetone may be carried over from the
cylinder and into the spectrometer. Acetone in the spectrometer can
damage seals, O-rings and hoses, degrade analytical performance and
precipitate flashbacks.
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Minimize the amount of acetone that is carried over with the
acetylene by:

¢ Replacing cylinders when their contents pressure drops below
700 kPa (100 psi)

¢ Ensuring that the rate of acetylene drawn off from each cylinder
is not excessive.

If high rates of consumption are observed, then connect two or more
cylinders in parallel to a manifold. This reduces the rate at which
acetylene is drawn from each cylinder.

To reduce the possibility of fire or explosion:

¢ Test the supply ‘plumbing’ regularly for leaks with a brush and
soapy water or a proprietary leak-detecting solution (never use a
naked flame when testing for leaks)

e ‘Crack’ the cylinder before use by gently opening the valve to
check for any drops or spray of acetone. Any cylinder showing
acetone should be returned to the supplier for replacement.

Use ‘Instrument Grade’ acetylene that is at least 99.5% pure.

Turn off fuel gas at the cylinder when you have completed your flame
analysis.

Refer also to your local regulations governing the use of acetylene.

Nitrous oxide

The decompression of high-pressure N>O gas at the regulator can
cause excessive cooling and eventual freezing of the regulator. To
prevent regulator malfunction and possible flashback, the gas should
be heated with an in-line or wrap-around heater.

Burners

Improper or careless use of burners can create explosion hazards
and fire hazards that can cause death, serious injury to personnel
and damage to equipment and property.

Whenever you handle burners, remember that the burner may be
very hot. Always use protective gloves to handle burners.

Agilent 240/280 Series AA User’'s Guide
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Burners are clearly identified by the fuel/oxidant combination for
which they are intended. Always fit the correct burner. Never
attempt to use an air-acetylene burner for nitrous oxide-acetylene, as
this causes a flashback.

Use only acetylene as the fuel gas.

Use only air or nitrous oxide as oxidant. Never attempt to use oxygen
or oxygen-enriched air, as this causes a flashback.

Burner interlocks are incorporated to minimize the possibility of
using the wrong burner. Never interfere with or attempt to bypass
any interlock fitted to this instrument.

To minimize the rate of burner blockage, the burner slot must be
cleaned and polished as described in the ‘Maintenance’ section.

Never allow burners to become blocked. Progressive burner blockage
can increase the static pressure in the liquid trap to the point at
which the liquid seal is breached. This can cause a flashback and
create an explosion hazard or a fire hazard.

Never allow carbon to build up on the slot, as glowing particles can
dislodge and fall through the slot, causing a flashback.

Always turn off the flame before attempting to clean the burner slot.
Never clean the slot of a burner while a flame is running.

Never leave a flame unattended.

Never disassemble or modify a burner. Never use a damaged burner.

Nebulizer

Incorrect assembly and fitting of nebulizers to an atomic absorption
spectrometer can create explosion hazards and fire hazards that can
cause serious injury to personnel and damage to equipment and

property.

Ensure that the nebulizer is correctly assembled and correctly fitted
to the spray chamber before lighting the flame. Nebulizers should be
correctly adjusted before lighting the flame.
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Never remove a nebulizer from the spray chamber while the flame is
on, and do not use a mechanical device (for example, a wire) to clean
the capillary of a nebulizer while a flame is operating. Always
extinguish the flame before removing the nebulizer from the spray
chamber.

Regularly test all connections for leaks. Rectify all leaks before
lighting the flame.

Liquid trap

Improper use of the liquid trap can create explosion hazards, fire
hazards, and toxic vapor hazards that can result in death or serious
personal injury.

The liquid trap interlock is incorporated to minimize the possibility
of attempting to operate the instrument with an empty trap or with
the drain tube missing. Never interfere with this interlock. Never
attempt to bypass this interlock.

Always fill the liquid trap with the same solvent that is being used for
your samples.

The trap is designed to provide a liquid seal under all normal
conditions with solutions having a specific gravity greater than 0.75.
Never use a solution or solvent having a specific gravity lower than
0.75, otherwise the liquid seal can be breached. This can create a
flashback and create an explosion hazard or a fire hazard.

A length of tubing must be connected to the drain outlet on the trap
and led to a suitable waste vessel. The free end of the tubing must
remain above the liquid in the waste vessel. Do not use glass waste
vessels—use vessels made of a material that will not shatter in the
event of a flashback.
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A length of tubing should be connected to the vapor vent (the upper
nipple) on the liquid trap when you are analyzing organic or toxic
liquids. This tubing should be led out from the sample compartment,
parallel to the drain tubing, and must slope downwards to enable any
liquid overflow to drain out and prevent the tubing from becoming
blocked. Do not lead the vapor tubing to the waste vessel. If
necessary, an active exhaust system should be used to draw away
toxic vapors. If you are not analyzing solutions of a toxic nature,
leave the vapor outlet uncovered.

Heat hazards

An open flame, burners, and other hot surfaces can present heat
hazards that can result in severe burns.

When operating a flame system, always operate your spectrometer
with the flame shield closed, and the sample compartment front
panel in place. Keep your hands out of the sample compartment
while a flame is burning.

When operating a flame system make sure that the chimney is in
place with the cutaway skirt (if present) to the back. Before you
touch the instrument chimney, turn off the flame and allow the
chimney to cool.

When you change burners, remember that the burner may be very
hot. Always use protective gloves when removing a burner from the
instrument.

Perchloric acid

Aspiration of perchloric acid and perchlorates into a nitrous oxide-
acetylene flame can create an explosion hazard that can result in
death or serious injury, including temporary or permanent
impairment of hearing.

Do not use perchloric acid unless it is absolutely essential for sample
preparation. If perchloric acid must be used, it may be possible to
reduce the risk of explosion by taking the following measures:

¢ Use an air-acetylene flame instead of a nitrous oxide-acetylene
flame.
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¢ Reduce the concentration of perchloric acid and metal in all
analytical solutions to the lowest practicable level. The
concentration of perchloric acid should be reduced in the
digestion stage and further reduced by extending the fuming
stage.

e Aspirate all solutions for the shortest practicable period.

e Aspirate distilled water between samples. Minimize the
aspiration of air.

e Use separate spray chamber/liquid trap and drain assemblies for
perchloric acid analyses and organic solvent analyses to prevent
perchloric acid from mixing with organic solvent residues.

When solvent extractions of perchloric solutions are performed, some of the acid
may dissolve in the organic solvent that is subsequently aspirated. Also, if the
organic solution is aspirated while floating on the surface of the acid, do not
allow the capillary tube to drop below the organic layer and suck up agqueous
perchloric acid.

26

When using perchloric acid, wear approved ear protectors and
approved safety glasses and ensure that all instrument safety covers
are in position.

Flashbacks

A flashback is an explosion of the gas mixture in the spray chamber,
which can occur for several reasons. For more details, refer to the
SpectrAA software Help.

Agilent AA spectrometers have several safety features in place to
prevent flashbacks, and flashbacks are very rare in circumstances
where instruments are properly maintained.

In the rare event that a flashback does occur, the Agilent AA
instrument safety features are designed to safely relieve the pressure
and minimize damage. In addition to reading the list below, refer to
the Maintenance section of this User’s Guide and the SpectrAA
software Help for recommended maintenance procedures to prevent
flashbacks.
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Analysis over many years has shown that in most cases, flashbacks
are associated with one or more of the following points. If you
experience a flashback, check this list to see if any of the points are
relevant, and take steps to remedy the situation.

1 Keep the burner clean. Deposits must not be allowed to build up
in or on the burner slot because they can partially block it (thus
causing the pressure to build up in the spray chamber and breach
the seal provided by the liquid trap), or glowing particles can fall
down through the slot into the spray chamber and ignite the
combustible gas mixture inside.

The use of a hard object to brush off glowing carbon particles
during flame operation is not recommended because of the
increased risk of knocking one of the particles down the slot.
When using an organic solvent, a reduced uptake rate should be
used to restrict the amount of liquid fuel that is fed to the flame.

2 The width of the burner slot must not exceed the maximum
design specification [Mark VIA: 0.47 mm (0.0185 in) for N.O;
Mark 7 0.46 mm (0.0181 in) for N;O; or 0.54 mm (0.021 in) for
air]. Even a small increase in width can greatly increase the
possibility of a flashback occurring.

The burner slot must be regularly cleaned according to the
instructions included in the ‘Maintenance’ chapter of this
manual.

3 Ensure that the spray chamber and liquid trap are kept clean.
If dirty solutions are being analyzed (for example, engine oils),
ensure that the spray chamber, liquid trap, float, and drain tube
are regularly cleaned and flushed with a suitable solvent so that
sludge does not build up in the parts.

4 Ensure that the correct O-rings are used on the burner, nebulizer
block and nebulizer, and that they remain undamaged.
Damage to O-rings in the spray chamber can result in the leakage
of gas that can be ignited by the flame and in turn set fire to the
spray chamber.
Damage to O-rings in the nebulizer can allow leakage of the
oxidant that can reduce the total flow of gas through the burner
slot and so increase the possibility of a flashback occurring.

5 The liquid trap must be filled with the same solution as the
matrix used for the standards and samples.
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The drain tube must be attached to the lower nipple of the liquid
trap, and it must slope downwards all the way to the drain vessel
so that the waste liquid drains smoothly.

The end of the drain tube must not be allowed to drop below the
level of the liquid in the vessel. (Conversely, the level of liquid
must not be allowed to rise sufficiently to cover the end of the
tube.)

When using organic or toxic liquids in the spray chamber, a vent
tube must be attached to the upper vent nipple of the liquid trap.
It must slope downwards (running parallel to the drain tube) to
prevent it becoming blocked should any liquid drain out, and be
vented to an active exhaust system.

All the above points must be observed because a sudden surge of
waste liquid can affect the pressure in the spray chamber and
result in a flashback.

Since N,O is stored in the cylinder under pressure as a liquid,
when it expands through the regulator it can cool the regulator
sufficiently to form ice on the outside and prevent it from
operating correctly.

Prevent freezing by using a heater on the N;O regulator on the
supply cylinder. Contact the supplier of the regulator for a
suitable heater.

As free acetylene is unstable at elevated pressure, it has to be
stored in the cylinder by dissolving it in acetone.

If the gas is withdrawn too quickly, or the cylinder pressure is
allowed to drop below 700 kPa, acetone may be drawn off in
sufficient quantities to affect analytical performance, damage
seals, O-rings and hoses, or even cause a flashback. Observe the
recommendations concerning the use of acetylene.

Where possible, do not perform digests with perchloric acid. As
this acid is known for forming unstable salts, operators using this
acid should ensure that the minimum amount is allowed to reach
the spectrometer, and that the burner, spray chamber and liquid
trap are thoroughly cleaned after each analysis to ensure that
unstable salts are not allowed to build up. Failure to do this can
result in unpredictable flashbacks.
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10 Aspirating solutions (especially alkaline/ammoniacal ones) that
contain high concentrations of Ag and Cu can lead to the
formation of acetylides that can spontaneously decompose and
cause a flashback.

See Page 85 for instructions on what to do if a flashback or flame
event occurs.

Furnace and Zeeman operation

Gases

The graphite tube atomizer gas supply system is designed for use
with inert gases and air.

Never use pure hydrogen with the graphite tube atomizer since this
could result in leakage and potentially explosive accumulation of
hydrogen. You may, however, use a proprietary, prepackaged mixture
of 95% argon (or nitrogen) and 5% hydrogen. Never attempt to create
your own mixture of hydrogen and an inert gas for use with the GTA
system.

Heat hazards

A hot furnace atomizer can present heat hazards that can result in
severe burns to personnel. Never put your hands in the sample
compartment while you are operating your furnace.

Allow the furnace atomizer to cool before removing it from the
sample compartment.

Vapors and fumes

Never place your head over the graphite tube atomizer while it is
operating. This could cause inhalation of hazardous or toxic fumes,
or your skin and eyes could be injured by corrosive vapors or fumes.

The chimney or the optional exhaust accessory must be in place for
furnace operation to ensure that toxic vapors and heat are
exhausted.
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UV radiation

When viewing the sample during the drying stage, use only a rear
coated mirror (as supplied) or the Tube-CAM option. Never look
directly at the furnace during either the ash or atomize stages.

Magnetic field (Zeeman only)

The magnet produces a variable magnetic field of up to 0.8 Tesla peak
at mains frequency in the workhead during the read stage.

To avoid interference with heart pacemakers or magnetic storage
media, keep them at least 300 mm from the magnet.
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The Agilent 200 series AA spectrometers are controlled by Agilent’s
innovative AA worksheet software. The Agilent series AA includes
the following instruments:

This documentation is appropriate for the following instruments:
240/240FS AA, 240Z AA, 280 AA, and 280Z AA.

The software is based on a spreadsheet that mimics an analyst’s
workbook and combines flame, furnace, Zeeman, and vapor
operation in one integrated package.

The SpectrAA Base, PRO and CFR software versions run under the
Microsoft Windows 7 64-bit (Service pack 1) operating system, and
provides the following:

¢ Innovative, easy to use interface
¢ Dedicated function keys for critical functions

¢ Extensive Help including audio and video demonstrations of how
to set up your instrument

e “Tool Tips” state the allowed range for each field
¢ Comprehensive error system

¢ The capacity to simultaneously operate one flame and one
furnace (deuterium or Zeeman) spectrometer simultaneously
from one computer (requires SpectrAA PRO version software)

¢ Features to assist users to achieve compliance with US FDA 21
CFR Part 11 requirements (optional CFR version only)
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Instrument Overview

Flame instruments front view

L5 Agilent Technalogies
280FS an

2
3
4
5
6
7
89
Where:
1. Flame shield 7. Flame-on button
2. Burner adjustment handles 8. Instrument status LED
3. Burner height adjustment 9. Power switch
4. Nebulizer and flow adjustment 10. Spray chamber and liquid trap assembly
(behind the grey cover)
5. Impact bead adjustment 11. Lamp compartment (Eight lamps are shown
6. Flame-off button here. A four lamp compartment is also available.)
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Flame instruments back view

Where:

1. Accessories serial port, such as the GTA | 7. C2H2 gas line
Viewing/Fume Extraction accessory

2. USB camera cable port 8. Air gas line

3. IEEE 488 cable port 9. N20 gas line

4. Power cable 10. Air purge port

5. Fuse and power setting housing 11. SIPS pump option port

6. UltrAA lamp option ports
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Zeeman instruments front view

Where:

1. GTA 120 Graphite Tube Atomizer

7. Zeeman AA instrument status LED
and power switch

2. Zeeman workhead

8. PSD 120 waste port

3. PSD 120 sample tray

9. PSD 120 rinse tube

4. PSD 120 Programmable Sample Dispenser

10. PSD 120 probe

5. Rinse solution

6. GTA 120 instrument status LED and power
switch

11. Lamp compartment (Eight lamps are
shown here. A four lamp compartment
is also available.)

See the User’s Guides supplied with the GTA 120 and PSD 120 for
more information about those accessories.
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Introduction

14
13
12
1
10
4 5 6 7 8 9

Where:

1. Accessories serial port, such as the GTA 8. GTA 120 power cable

Viewing/Fume Extraction accessory

2. USB camera cable port 9. GTA 120 fuses

3. AA instrument IEEE 488 cable port 10. Water in

4. Power cable 11. Water out

5. UltrAA lamp option port 12. Alternate gas inlet, typically nitrogen

or air
6. UltrAA accessory and fuses 13. Normal gas inlet, typically argon
7. Air purge port 14. GTA 120 IEEE 488 cable port
35
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Furnace instruments front view

Where:

1. GTA 120 Graphite Tube Atomizer

8. Flame-on button

2. Workhead

9. Instrument status LED

3. PSD 120 sample tray

10. AA instrument power switch

4. PSD 120 Programmable Sample
Dispenser

11. PSD 120 waste port

5. Rinse solution

12. PSD 120 rinse tube

6. GTA 120 instrument status LED and
power switch

13. PSD 120 probe

7. Flame-off button

14. Lamp compartment (Four lamps are
shown here. An eight lamp compartment
is also available.)

See the User’s Guides supplied with the GTA 120 and PSD 120 for
more information about those accessories.
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Where:

Introduction

" 12 13

1. Accessories serial port, such as the GTA
Viewing/Fume Extraction Accessory

10. SIPS pump option port

2. USB camera cable port

11. Air purge port

3. AA instrument |IEEE 488 cable port

12. GTA 120 power cable

4. AA instrument power cable

13. GTA 120 fuses

5. AA instrument fuse and power setting housing

14. Water in

6. UltrAA lamp option ports

15. Water out

7. C2H2 gas line

16. Alternate gas inlet, typically
nitrogen or air

8. Air gas line

17. Normal gas inlet, typically argon

9. N20 gas line

18. GTA 120 IEEE 488 cable port

Agilent 240/280 Series AA User's Guide
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Installation requirements

Before you receive your instrument, you are given an Agilent AA Site
Preparation Guide; which describes the environmental and operating
requirements of the Agilent AA system. Prepare your laboratory
according to those instructions before the Agilent AA can be
installed. Keep the Site Preparation Guide for future reference. If you
have misplaced your copy, you can obtain a replacement from your
local Agilent office.

Agilent AA documentation

This manual covers the installation of the Agilent SpectrAA software
for 240/280 series AA instruments. Instructions for installing,
operating, and maintaining the instruments are included in the
SpectrAA Help (see Page 74).

Operating instructions for the Sample Introduction Pump System
(SIPS) and other AA accessories are given in the manuals
accompanying the accessories or in the SpectrAA Help

Conventions
The following conventions have been used throughout this manual:

e Single quotes (‘ ) indicate a selection that you can make from
several choices, such as radio buttons, checkboxes, and software
items.

e ALL CAPITALS indicates text that you must type in from the
keyboard (for example, type SETUP at the prompt).

Specifications

38

Equipment class

Your Agilent AA instrument is designed for indoor use only and is
classified suitable under Equipment Class I category.
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Introduction

The installation category is II, based on IEC61010-1. The installation
category implies the regulation for impulse withstand voltage. It is
also called the ‘Over voltage category’. ‘I’ applies to electrical
equipment with a nominal supply voltage up to 300 V.

Pollution level

The pollution level is 2, based on IEC61010-1. Pollution level
describes the degree to which a solid, liquid, or gas that deteriorates
dielectric strength is adhering. ‘2’ applies to a normal indoor
atmosphere, where only nonconductive pollution occurs.

Environmental
Condition Altitude Temp Humidity (%RH)
(°C) non-condensing
Non-operating (transport) 0-2133 m 5-45 20-80
(0-7000")
Operating within 0-853 m 10-35 8-80
performance specifications (0-2800")
853-2133 m 10-25 8-80

(2800-7000")

For optimum analytical performance, it is recommended that the
ambient temperature of the laboratory is between 20-25 °C and held
constant to within +2 °C throughout the entire working day.

Agilent 240/280 Series AA User's Guide
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Power

System unit Required supply voltage Rating

240 AA 100, 120, 220/230, 230/240 VAC 170 VA
50 or 60 Hz

280 AA 100, 120, 220/230, 230/240 VAC 230 VA
50 or 60 Hz

Zeeman version

240Z AA 208-240 VAC 1000 VA **
50 or 60 Hz

280Z AA 208-240 VAC 1000 VA **
50 or 60 Hz

GTA accessory power supply  208/220/240 VAC50 or 60 Hz 15A

** In normal operation, the Zeeman and GTA units draw surge
currents more than the nominal rating. Power supplies to these units
must be isolated from other supplies to the system and should
include delayed action protection devices such as circuit breakers or
motor start fuses.

The VA and current figures above are the typical continuous VA and
current drawn by AA and GTA. During the atomize cycle, surge
currents for very short spans of time (between 1 and 5 second) may
be drawn by AA (up to 48 A) and by GTA (up to 40 A).
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Introduction

Agilent AA instruments are supplied with different power plugs to
suit the area into which they are sold:

AA instrument

GTA 120, Zeeman

Area - code Plug supplied
Australia -00 10 A, 250 VAC Clipsal 439D15M
Complies with AS3112
USA -01 Complies with NEMA 5-15P Complies with NEMA L6-30P
(Hubbell #2621)
Canada -01 Complies with NEMA 5-15P 20 A, 250 VAC, Complies with
NEMA L6-20P
(Hubbell #2321+)
Europe -02 Perena 3410 (Complies with CEE 7 Kaiser CEBEC 616 VDE
Sheet VIl or NFC 61.303) (Complies with DIN 49441R2)
Suitable socket required
Australia -00 General purpose 10 A 250 V outlet Dedicated circuit, 15 A 250 V
(HPM 7817, Clipsal 15) outlet
(HPM 787/15, Clipsal 15/15)
USA -01 To comply with NEMA 5-15R (15 A To comply with NEMA L6-30R
supply) (Hubbell IG 5262) (30 A supply)
(Hubbell #2626)
Canada -01 To comply with NEMA 5-15R (15 A 20 A, 250 VAC, Complies with
supply) (Hubbell IG 5262) NEMA L6-20R
(Hubbell #2326+)
Europe -02 To comply with CEE 7 standard No.7 No standard known (Kaiser CEBEC

Power supply, current rating
and overload protection

Power supply

Sheet VII, or Norma Francais C61.303

Sheet V.A.
Between 5 and 20 A

Single phase

702 type 31/131.5)

Between 30 and 40 A

Single phase

Do not position the equipment so that it is difficult to operate the
disconnecting device.

Agilent 240/280 Series AA User's Guide
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Other Electrical Connections

Rear of instrument:

« IEEE 488

e Accessory, 9-way female D-range type

e Accessory, MCA, 6-way DIN type (AA280FS and AA280Z only)
e USB port, optional

e UltrAA lamp connections: Burndy circular 6-way, optional
(actual number depends on the model and option selected)

Shock Hazard
High voltage— To maintain safety, only the UltrAA lamp power supplies
should be used at these connections.

Some pins will become energized (300 VDC) when an UltrAA lamp is in a
matching socket. To avoid death or electric shock, NEVER touch any exposed
pins.

Certaines broches du culot des lampes sont sous tension (300 VCC) a la mise
en place d'une UltrAA lampe. Pour éviter I'électrocution ou la mort, ne jamais
toucher les broches sous tension.

Front of instrument:

e Zeeman workhead CPC 14 way connection behind the Left cover
(Zeeman only).

Shock Hazard

To prevent connector damage, switch OFF the instrument before inserting the
plug and always turn the locknut fully clockwise to the detent position. To
maintain safety, only the Zeeman workhead connector should be used at this
connection.
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Lamp bay:

e Deuterium lamp:
Molex 3-way connection, in lamp compartment (behind lamp
panel in lamp compartment on 240/280 series AA instruments).

m Shock Hazard

To maintain safety, only the deuterium lamp should be used at these
connections.

¢ Hollow cathode lamps:
Four lamp capacity on the 240 series AA
Eight lamp capacity on the 280 series AA

m Shock Hazard

High voltage — To maintain safety, only hollow cathode lamps should be used
at these connections.
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Fuses

For continued protection against fire hazard replace fuse only with same type
and rating.

Non-Zeeman

240 series AA

T2.5 A H250 V, IEC 127 sheet 5, 5 x 20 mm (100-120 & 220-240 VAC)
280FS AA

T4 A H250 V, IEC 127 sheet 5, 5 x 20 mm (100-120 & 220-240 VAC)
Zeeman

240Z/280Z AA

15 A long delayed-action circuit breaker with a thermal cutout.
T3.15 A H 250 V, IEC 127 sheet 5, 5 x 20 mm (208-240 VAC)

T3.15 mA L 250 V, IEC 127 sheet 2, 5 x 20 mm (208-240 VAC)

T1 A L 250 V,IEC 127 sheet 2, 5 x 20 mm (208-240 VAC)

T6-3 AL 250 V, IEC 60127-2 sheet 3, 5 x 20

T800 mA L 250 V, IEC 127 sheet 2, 5 x 20 mm (208-240 VAC)

For safety reasons, any other internal fuse or circuit breaker is not operator
accessible, and should be replaced only by Agilent field service engineers.

Fuse information on the rear of the instrument is the most up to
date.
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Gas supplies

CzH: Air N20 Air purge
Instrument grade Must be clean and  Instrument grade
>99.5% pure dry. (Air filter to be  >99.5% pure
used if required)
Allowed range 65-100 kPa 245455 kPa 245455 kPa 245-455 kPa
(9.5-14.5psi) (35-65 psi) (35-65 psi) (35-65 psi)
Recommended 75 kPa (11 psi) 350 kPa (50 psi) 350 kPa (50 psi)
Typical flow rate  0-10 (L/min) 13.5-20 (L/min) 11-16 (L/min) 10 (L/min)
Connection 1.8 m (6 ft) length 1.8 m (6 ft) length 1.8 m (6 ft) length Barb to take
of 6.3 mm (1/4 in) of 6.3 mm (1/4 in) of 6.3 mm (1/4 in) 6.3 mm (1/4 in)
ID red hose with ID black hose with 1D blue hose with hose
9/16 in-18UNF L/H  9/16 in-18UNF 3/4 in-16UNF
thread fitting# fitting# fitting#

#Adaptors are available

Other gas connections

Sample compartment: Push-on Air/N;O connector for burner
Push-on C;H; connector for burner

Weights and dimensions

Spectrometer System unit Width Depth Height Weight

240 AA instrument only 790 mm (31in.) 585 mm (23in.) 575 mm (22.5in.) 56 kg (123 Ib)
240 AA instrument and 1215 mm (48 in.) 780 mm (31in.) 880 mm (35in.) 97 kg (213 Ib)
shipping box

280 AA instrument only 790 mm (31in.) 585 mm(23in.) 735 mm (29 in.) 69 kg (152 Ib)
280 AA instrument and 1170 mm (46 in.) 890 mm (35in.) 890 mm (35in.) 106 kg (234 Ib)
shipping box

280Z AA instrument only 790 mm (31in.) 585 mm (23in.) 735 mm (29 in.) 61 kg (135 Ib)
280Z AA instrument and 1170 mm (46 in.) 890 mm (35in.) 890 mm (35in.) 92 kg (203 Ib)
shipping box

Agilent 240/280 Series AA User's Guide 45



Introduction

46

This page is intentionally left blank.

Agilent 240/280 Series AA User’'s Guide



Installation

o0 @ @ ® ¢ - 3 [nstallation

o o PC requirements 48
o ° ® ¢ o Installation procedure overview 49
¢ Guidelines for software installation 49
) Installing the SpectrAA CFR software 50
Installing the SpectrAA Base software 50
Configuring the SPS 4 autosampler 53
Determining the SPS 4 COM port 53
Installing the SpectrAA PRO software 54
GPIB communications 55
Connecting and configuring an Agilent AA spectrometer
DUO system 59
Configuring the software to use manual sampling 62
USB to RS-232 interfaces 62
Starting the SpectrAA software 63

SpectrAA Release Notes and Software Status Bulletin 64
Installing the drivers for the Tube-CAM Furnace Camera

option 65
Printer setup 67
Troubleshooting 67
Service installation module 67
Software re-installation 68

This chapter describes how to prepare your personal computer (PC)
and printer for use with the Agilent AA system and install the
SpectrAA software on your PC.
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PC requirements

If you are supplying your own PC for use with an Agilent AA
instrument, the recommended configurations of that PC are listed on
the following page.

Recommended PC configuration

e IBM compatible PC with 2.66 GHz processor

e 4 GBRAM

e 500 GB Hard disk drive

e 256 MB Graphics card supporting 1024 x 768 resolution

e 16 speed DVD drive

¢ Integrated audio/sound card and speakers

e Keyboard and Mouse

e 19 in LCD Monitor

e Windows 7 Professional 64-bit (Service pack 1) operating system

The PC must have one spare PCl expansion slot for the Agilent PCI-GPIB
interface card.

48

If an Agilent SPS 3 Sample Preparation System or ETC 60 accessory
is being used an RS232 port is required for each of these.

A USB port is required if the Agilent SPS 4 Autosampler or camera
option is used.

Locate the PC keyboard and mouse for ergonomically correct access.
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Installation

There are three software installation scenarios:

¢ SpectrAA Base (for use with SpectrAA Base version 5.2 or
greater and Windows 7 Professional 64-bit SP1 operating

systems)

e SpectrAA PRO (for use with SpectrAA PRO version 5.2 or greater
and Windows 7 Professional 64-bit SP1 operating systems)

e SpectrAA CFR (for use with SpectrAA CFR version 5.2 or greater
and Windows 7 Professional 64-bit SP1 operating systems only)

The following table lists the procedure for each software installation

scenario.

SpectrAA Base (Page 50)

SpectrAA PRO (Page 54)

SpectrAA CFR (Page 50)

1. Install SpectrAA Base 1.
2. Configure instrument for 2.
use

3. Install SpectrAA Help and 3.

Videos
4. Install GPIB 4.
Communications Card or 5.

USB-GPIB-HS Converter

Install SpectrAA Base
Configure first instrument for
use

Install SpectrAA Help and
Videos

Install SpectrAA PRO

Install GPIB Communications
Card or USB-GPIB-HS Converter

. Configure for DUO operation (if

DUO is used)

Guidelines for software installation

1
2

=

Install SpectrAA Base
Configure first instrument for
use

Install SpectrAA Pro

Install SpectrAA CFR

Install GPIB Communications
Card

Install SpectrAA Help and
Videos

Configure for DUO operation (if
DUQ is used)

The following information assumes that you are working on a clean,
empty hard disk. If you have any other files on the PC hard disk,
ensure that you make backups of these files before continuing.

Agilent will not assume responsibility for the loss of data files or third-party

software.

Agilent 240/280 Series AA User's Guide
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Refer to the documentation supplied with Microsoft Windows for
instructions on installing the Windows operating system. It is the
responsibility of the customer to ensure that the Microsoft Windows
operating system is installed on the computer.

Installing the SpectrAA CFR software

Because the CFR version is an upgrade to the Base installation, the
SpectrAA Base version 5.2 or greater and SpectrAA Pro version 5.2
or greater must be installed before any installation of the CFR
version.

For complete installation instructions, see the SpectrAA Software
Installation Instructions for 21 CFR Part 11 Environments supplied
with the SpectrAA CFR software.

Installing the SpectrAA Base software

This procedure is for SpectrAA version 5.2 or greater and Microsoft Windows 7
Professional 64-bit SP1 operating systems only.

If you have an SPS 4 Autosampler and have plugged in the USB cable into the PC
and autosampler, remove it from the PC before installing the SpectrAA software.

Close down all Microsoft Windows applications.
Turn off all SpectrAA instruments.

Insert the SpectrAA Base CD-ROM into your CD-ROM drive. The
installation program should start automatically. If the program
does not autostart, in Microsoft Windows Explorer, navigate to
the SpectrAA Base disc and then double-click SpectrAABase.exe.

4 Click Yes on the User Account Control window to run the
program.

5 Select the language from the drop-down menu to use during the
installation of the SpectrAA software. Click OK.

6 Select Next to start the installation.
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7 Review the License Agreement and then select I accept the
agreement and then click Next or ‘Cancel’ if you do not accept
the agreement. Clicking ‘Cancel’ stops the software installation.

Follow the prompts, selecting Yes, Next, or OK on each page.

The SpectrAA User Information window is displayed. Check that
the selections are correct, or re-enter them, and then click Next.

10 Follow the prompts, selecting Yes, Next, or OK on each page.
11 Click Install.

12 From the ‘SpectrAA Instrument Configuration’ window, select
Instrument #1 model, gasbox type, and lamp system from the
drop-down list. Then continue with Step 13.

If you are running a Duo system that includes an Agilent 55B AA instrument,
the 55B AA MUST be entered as Instrument #1 in the SpectrAA Instrument
Configuration dialog box.

Do not configure the DUO settings for Instrument #2 at this time. It will be done
later in the procedure.

Ensure that the DUO check box is not ticked.

13 If you are using any accessories, click the Accessories tab in the
‘SpectrAA Instrument Configuration’ window. Select your GTA
(Graphite Tube Atomizer), Flame Autosampler and /or ETC 60
from the drop-down lists.

a Ifyou select GTA 120, the option for high capacity racks is
enabled. Select this option to enable support for the optional
high capacity carousel (130 x 1.1 mL samples and 5 x 10 mL
standard/modifier solutions).

b If you select Agilent SPS 3 flame autosampler, click Edit
COM port parameters to define the COM port and the
settings to be used for communicating with the autosampler.
Refer to the SPS 3 operation manual for details of the
required communications parameters.
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There may be two options for the SPS 3 autosampler if other Agilent software
has been installed. Select ‘SPS3 Autosampler’ for the SpectrAA software. Do
not select ‘SPS3 Auto-sampler’.
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If you have an SPS 4 autosampler, select it from the list. See Page
53 ‘Configuring the SPS 4 Autosampler’ for more instructions
after the SpectrAA Base installation is complete.

¢ Ifyou are installing the ETC 60 and want to control this
accessory from the SpectrAA software, select the COM Port
from the drop-down menu to be used to control this
accessory.

Click OK. The NI-GPIB software may take some time to install.
Click Next to install the Agilent SPS 4 driver and then Finish
when prompted.

Once the entire installation is complete, click Finish.

A message may appear prompting you to install the QuickCam
drivers. Click OK to dismiss the message. Install the SpectrAA

PRO and/or the GPIB Communications device first. The
QuickCam drivers are installed later in this procedure.

Click OK to install the SpectrAA Help.

Remove the SpectrAA Base CD and then insert the SpectrAA
Help CD. The installation program should start automatically. If
the program does not autostart, in Microsoft Windows Explorer,
navigate to the SpectrAA Help CD and then double-click
install.exe.

Select OK to start the installation.

b Click Yes on the User Account Control window to run the
program.

¢ Click Install Help to start the SpectrAA Help and Videos
installation.

d Click Finish when the installation is complete.
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20 Perform the following two procedures, if applicable:

21

If you have an SPS 4 Autosampler, proceed to the next section
‘Configuring the SPS 4.

If you are installing SpectrAA PRO, proceed to ‘Installing the
SpectrAA PRO Software’ on Page 54.

Reboot your PC and then install the PCI-GPIB communications

card (see Page 56) or the USB-GPIB-HS converter (see Page 59).
Once this step is complete, if you have a DUO system, you must
then connect both instruments to the PC and then configure the
IEEE address settings (see Page 59).

Configuring the SPS 4 autosampler

To configure the SPS 4 autosampler:

1
2
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Shut down the SpectrAA software if it is open.

Follow the instructions provided in the SPS 4 Autosampler
User’s Guide to set up the hardware.

Plug one end of the USB cable into the USB port on the
autosampler and the other end into a USB port on the computer.

Navigate to C:\Program Files (x86)\Agilent\SP100\Run.
Double-click the IHelper.EXE application.
Click the Accessories tab.

Select Agilent SPS 4 Autosampler in the Flame Auto Sampler
section if needed.

Click OK to save the changes.

Continue to ‘Installing the SpectrAA Pro software’ if applicable
or skip to ‘GPIB Communications’ on Page 55.

Determining the SPS 4 COM port

When running the Calibration Wizard, you must select the SPS 4
COM port to start communication between the SPS 4 and the PC. The
following procedure explains how to determine the COM port.
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For information on how to use the Calibration Wizard, see the SPS 4
Autosampler User’s Guide or the SpectrAA Help > Accessories
>SPS 4 section.

To determine the COM port:
1 Click Start > Control Panel > Device Manager.
2 Expand ‘Ports’.

3 Find the ‘SPS4 USB Interface’ and note the assigned COM port
(COMS5 in the example shown below).

!i-:" Metwork adapters

473 Ports (COM & LPT)

: ai) %' Communications Port (COML)

X 7 Cemmunications Port (COM2)

- <" Printer Port (LPT1)

: X +" SPS4 USB Interfacel(COMS)
. 2} Processors

Figure 2. Example of SPS 4 USB interface COM port

Installing the SpectrAA PRO software

Installation of the SpectrAA Base version 5.2 or greater must be completed
before installing the SpectrAA PRO version 5.2 or greater software. Refer to Page
50 for details.

The selections entered during installation of the Base software (such as User
Information, Directory Location) are used for the PRO installation.
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To install the SpectrAA PRO software:
1 Close down all Microsoft Windows applications.

2 Insert the SpectrAA PRO CD-ROM into your CD-ROM drive. The
installation program should start automatically. If the program
does not auto-start, in Microsoft Windows Explorer navigate to
the SpectrAA Pro CD and then double-click SpectrAAPro.exe.
Select OK to start the installation.
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Click Yes on the User Account Control window to run the
program.

Select the language from the drop-down menu to use during the
installation of the SpectrAA software. Click OK.

Select Next to start the installation.

Review the License Agreement and then select I accept the
agreement and then click Next or ‘Cancel’ if you do not accept
the agreement. Clicking ‘Cancel’ stops the software installation.

Follow the prompts, selecting Yes, Next, or OK on each page.

A dialog box appears asking for confirmation of the installation
destination for SpectrAA Pro.exe. Click Yes to install into the
previously created SP100\Run folder and then click Next.

Click Install to begin the installation.

The SpectrAA Instrument Configuration window is displayed
again. Check that the selections are correct and click OK.

During installation, you may be asked to delete the files
‘Workgrp.ini’ and ‘User.ini’. These are created if you opened the
SpectrAA software after installing SpectrAA Base but before
installing SpectrAA PRO. Select ‘Delete this file’ (recommended)
for both dialog boxes.

Click Finish.

Click ‘Yes’ to install the SpectrAA Help if you skipped that step
during the SpectrAA Base installation or ‘No’ to cancel the Help
installation if it has already been completed.

Once the software installation is complete, restart your
computer.

GPIB communications

Either a GPIB communications card or the optional USB-GPIB-HS
converter must be installed in your computer to interface the
computer and the Agilent AA. See the next section for information on
installing the PCI-GPIB communications card or Page 59 for
connecting the USB-GPIB-HS converter.
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Although the Agilent field service engineer will install the GPIB communications
device for you during the installation process, you may need to configure the
driver yourself at some later stage, for example if you change the PC.

Installing the PCI-GPIB communications card

The National Instruments PCI-GPIB card supplied with the
instrument must be installed in your PC to interface the PC with the
Agilent AA spectrometer and accessories.

The components on the communications card and in the PC are highly static-
sensitive. To avoid damaging these components you must drain any static
charges from your body before installing the board, and prevent the generation of
any new static charges during the installation.

This can be done by wearing an ESD (electrostatic discharge) wrist strap
attached to a grounding point. You can obtain a disposable ESD strap from
Agilent, otherwise you can obtain one from your local electronics supplier.

To install a National Instruments PCI-GPIB communications card:

Ensure that the SpectrAA software has been installed.

56

1 Turn off and unplug the computer.

2 Remove the cover, following the instructions in the manual
provided with the computer.
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3 Attach one end of the ESD strap to a bare metal part of the PC
chassis and wrap the other end around your wrist.

4 Remove a blanking plate from one of the empty slots in the
computer.

5 Remove the card from its static-shielded packaging. Do not touch
the gold edge connectors.
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6 Press the card firmly into the empty PC slot. The gold edge
connectors should slide firmly into the matching sockets of the
PC slot. Secure the card with the screw.

8 Connect the cable between the instrument and the computer (one
end plugs into the interface board in the computer, and the other
plugs into the socket in the rear of the instrument).

9 Connect the computer to the mains power.

10 Turn on the computer.

Configuring the PCI-GPIB communications card

Microsoft Windows 7 uses ‘plug-n-play’ for fully automatic setup.
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Installing the USB-GPIB-HS converter
To install a National Instruments USB-GPIB-HS converter:

NOTE Ensure that the SpectrAA software has been installed. Only follow this procedure
if you are not using the PCI-GPIB communications card.

1 Turn off the computer.

2 Connect one end of the converter to the instrument and the other
end to the USB connection on the back of the computer.

3 Turn on the computer.
Connecting and configuring an Agilent AA spectrometer DUO system

Setting up for DUO operation and connecting the IEEE cables

NOTE Install SpectrAA Base and PRO or CFR software and the GPIB communications
card or USB-GPIB-HS converter first before performing this procedure.

To set up and connect an AA Duo system:
1 Open SpectrAA.

2 On the ‘Index’ page, click the instrument link on the left side of
the page. The ‘SpectrAA Instrument Configuration’ dialog box
opens.

3 Ensure ‘Duo system’ is not ticked and that an instrument is
selected in the ‘Instrument #1’ tab.

Restart SpectrAA to save the configuration changes.

5 Connect both instruments to the PC using IEEE cables as shown
in the following diagram. Do not turn on the instruments.
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6 Return to the ‘Index’ page of SpectrAA and reopen the ‘SpectrAA
Instrument Configuration’ dialog box.

Select the Duo System checkbox.

Select the appropriate models in the drop down box for
Instruments #1 and #2.

If you are running a Duo system that includes an Agilent 55B AA instrument,
the 55B AA MUST be entered as Instrument #1 in the SpectrAA Instrument
Configuration dialog box.

60

9 Click OK to close the dialog box.

10 Restart SpectrAA to save the configuration settings.

Configuring the IEEE addresses for Agilent AA-DUO operation

If you are running an Agilent AA-DUO system, you must reconfigure
one of the instruments so they have different IEEE addresses. Agilent
55B AA instruments should have a default IEEE address of 1. Agilent
240FS AA, 240Z AA, 280FS AA and 280Z AA instruments should
have a default IEEE address of 9. Because 556B AA’s must be
Instrument #1 in the configuration dialog, Instrument #2 will always
have a default IEEE of 9. It is important not to change the IEEE
address of a 556B AA as it may cause conflicts with the inbuilt
computer.

1 Close SpectrAA if it is open.

2 Navigate to C:\Program Files (x86)\Agilent\sp100\Run and then
double-click DUAL.EXE. Click OK to start the program.

3 A window appears asking you to turn on the instrument you wish
to reconfigure. You must select ‘Instrument #2’ in the
configuration. Switch on the instrument and then click OK.

Do not turn on the first instrument.
A command window is displayed. The process may take about a
minute. During this time, you will hear the instrument resetting.

4 Click the Microsoft Windows Start button.
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b5 In the ‘Search programs and files’ field type cmd.exe. Select

cmd.exe from the list that appears.
I » Al Programs

e

6 Type one of the following options and then press Enter on the
keyboard:

For a Duo system with a 556B AA:

CD C:\Program Files (x86)\Agilent\SP100\Run\setaddr.exe —q1:8
For a Duo system without a 556B AA:

CD C:\Program Files (x86)\Agilent\SP100\Run\setaddr.exe —q9:8

The dialog should say that both addresses (1 and 8 or 8 and 9)
are ‘found’.

Duo mode will only work if the instrument selected as ‘Instrument #1" in the
SpectrAA Instrument Configuration dialog box retains its default IEEE address
(that is, 1 for 55B or 9 for 240FS, 240Z, 280FS or 280Z.

7 Restart the computer, turn on both AA instruments, and then
start the Agilent SpectrAA software.

The instruments are now ready to be used as a simultaneous
flame/furnace system. Refer to the Help for further information on
dual instrument operation.

During dual instrument operation, do not turn any connected instrument ON or
OFF while readings are being taken.
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Configuring the software to use manual sampling

If you are NOT using any flame autosamplers, set the Sampler Type
in the Accessories tab of ‘SpectrAA Instrument Configuration’ dialog
box to the SPS 5 Autosampler. The SPS 5 Autosampler uses IEEE
communications instead of RS-232 communications. By specifying
the flame autosampler type as the SPS 5 Autosampler (even though
no autosampler is used), the software will not capture the RS-232
port during start-up or shut down of the SpectrAA software. This will
minimize delays during start-up, operation, and shut down of the
software.

To define the SPS 5 flame autosampler:

1 Activate the IHelper.EXE application (from the installation drive:
\Program Files (x86)\Agilent\SP100\Run directory); OR click the
model number displayed at the Main Index page of the SpectrAA
software. This displays the ‘SpectrAA Instrument Configuration’
dialog box.

2 From the ‘SpectrAA Instrument Configuration’ dialog box, click
the Accessories tab.

3 Select Varian SPS5 Autosampler in the Flame Auto Sampler
section.

4 To complete the installation and configuration, shut down and
restart the SpectrAA software, as prompted.

USB to RS-232 interfaces

There are several USB to RS-232 adapters available for use on
computers that are not fitted with or not equipped with sufficient
RS-232 interfaces. Depending on the instrument configuration,
operation of all accessories may require the use of two RS-232
interfaces:

¢ An RS-232 interface is required for operation with the SPS 3
autosampler

¢ Another RS-232 interface is required for software control of the
ETC 60 Electrothermal Temperature Controller.
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Other modem and LIMS system may be also connected to the available RS-232
COM ports.

Where there are not enough RS-232 interfaces to support all the
devices that use these COM ports, an acceptable alternative is to use
a USB to RS-232 adapter.

To use a USB to RS-232 adapter:

1
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Install the USB-RS-232 device according to the manufacturer’s
specification.

Open the ‘Windows Control Panel’.

Select System.

Select the Hardware tab and then the Device Manager.
Locate the COM USB Com port and open Properties.

Select the Port Settings tab and open the Advanced settings.

Set the COM PORT number to 1 to 4 using an available number
from the drop-down list. If the numbers are already used, you
have to set one of the other Com ports to a higher number and
then set the one you are going to use to the vacancy created.
SpectrAA software only accepts values from 1 to 4.

Close all dialog boxes.

Shut down and restart the computer. You may need to repeat this
process if the port was not enabled the first time due to it being
used by another device.

Starting the SpectrAA software

To start the SpectrAA software:

1

Click Start > (All) Programs > SpectrAA and then SpectrAA
again. Alternatively, double-click the SpectrAA icon on the
desktop.

The first time the SpectrAA software is opened a Software
Registration dialog appears. Click Next.
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Ensure that the user of the SpectrAA software completes the software
registration. For further information, refer to the Software Registration Help.

3 Complete all the fields on the ‘Customer Details’ page. Click
Next.

The Product Key is found on the cover of the Agilent SpectrAA software CD
case that was delivered with the instrument.

Complete all the fields on the ‘Product Details’ page. Click Next.
Complete all the fields on the ‘Work Environment Details’ page.
Click Register.

~N o e A

A dialog appears stating ‘Your Agilent Software Registration has
been successful’.

If your computer is not connected to the Internet, refer to the Software
Registration Help for further information.

8 The application will now open, and you can collect your data.

SpectrAA Release Notes and Software Status Bulletin

64

Refer to the SpectrAAReleaseNotes.pdf file in the installation
directory and the Software Status Bulletin document for further
details. The file includes latest release information and important
notes including the detail of any known problems and suggested
work-arounds.
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Installing the drivers for the Tube-CAM Furnace Camera option

These instructions are required only if the Tube-CAM furnace video option has
been fitted to your instrument.

It is only necessary to install the driver files listed in the following
procedure. While it is possible to install all options, these are not
necessary for operation of the camera in SpectrAA software.

This installation refers to Logitech C525 cameras.

Driver installation

To install the drivers:

1 Ensure the SpectrAA software has been installed and the
computer has been restarted. Do not open the SpectrAA software
and do not connect the camera.

Insert the software CD into the disc drive.

Navigate to the installation CD and double-click ‘Iws251.exe’.

Select your preferred language in the ‘Preferred Language’ dialog
box on the ‘Welcome’ screen and then click Next.

5 Ensuring that the camera is not connected (contrary to screen
instructions) click Next.

6 On the ‘Install Webcam Software’ screen (see Figure 3):

b
c
d

Select ‘Logitech Webcam Software’.
Deselect ‘Logitech Motion Detection’.
Select ‘Logitech Webcam Drivers’.
Click Next.
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© Logitech Webcam Software Installation DEx

Logitech Webcam
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Figure 3. Logitech Webcam Drivers installation window
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If an ‘Update’ screen is displayed, click Next.
The ‘Installing Software’ screen is displayed.

After the installation has completed the ‘Check Settings’ screen is
displayed. Click Next.

The software is now installed. Click Checkout my webcam.
The Logitech Webcam Software is displayed.

Plug in the Logitech Webcam into the USB port on the
spectrometer.

If installation is successful an image of a Logitech Webcam
camera is displayed on the software window.

Select Quick capture and then Controls.

The image from the Tube-CAM video is not currently displayed in
the ‘Webcam Control’ window because the hollow cathode lamps
are not yet illuminated.

On the ‘Controls’ screen:
a Deselect ‘RightSound’
b  Deselect ‘RightLight’.
¢ Deselect ‘Autofocus’.
d

Select ‘Advanced Settings’.
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13 When ‘Advanced Settings’ are displayed:
a Deselect ‘Auto’ to the right of the ‘Gain’ slider.
b Set the ‘Exposure’ and ‘Gain’ sliders to maximum.
¢ Click Save.

The camera image appears black because the SpectrAA is turned off.

Printer setup

The printer must be a make and model supported by Microsoft
Windows. To install your printer, follow the instructions provided
with the printer. For more information, refer to your printer
documentation or Microsoft Windows Help.

Troubleshooting

This section contains solutions to some common problems you may
encounter during the installation of the SpectrAA software.

The SpectrAA software is not communicating with the instrument.

¢ Ensure that the computer has been restarted after installing the
software and the GPIB card or USB-GPIB-HS converter.

¢  Check the cables and connections.

¢ Check that the instrument and any associated accessories are
turned on.

e Check that you are not running the Simulator software. (Select
Help about system information.)

¢ Ensure that the PCI-GPIB driver has been installed and
configured. Refer to Pages 56 and 58 for details.

Service installation module

The installation test software is accessed directly from the
Administration window. As shown below, this control is only
activated when the software has been installed. The tests available
are a subset of the full Instrument Validation program. This software
must be installed from the Service folder of the BASE CD.

Agilent 240/280 Series AA User's Guide 67



Installation

68

To do this:
1 Insert the SpectrAA Base CD in the computer CD-ROM drive.

2 Use Windows Explorer to open the Service folder ‘D:\service’,
where ‘D’ is the CD-ROM driver letter.

3 Locate and run the setup.exe file to install the necessary
components and enable the VALIDATE button in the
Administration window.

Installation and commissioning tests can be selected and run from
the ‘Installation’ test window that is displayed. This allows easy
testing and provides a report of the tests conducted covering power-
on self tests, safety interlocks, and wavelength performance checks.

Software re-installation

If you are reinstalling the software, uninstall all previous software
and delete the National Instruments-488.2 drivers using the
‘Add/Remove Programs’ feature in the Windows Control Panel.
Delete all files in the ‘Run’ and ‘Workgrp.&’ folders including any
subfolders. Do not delete your data files.
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The Agilent AA system software (SpectrAA) is a powerful interface
that provides high levels of spectrometer control and is easy to use.
This chapter provides a brief overview of the SpectrAA software to
help you familiarize yourself with its various windows. A more
detailed description and instructions for use are included in the
extensive Help. The optional SpectrAA CFR version software offers
you the tools to help you achieve compliance with the US FDA 21
CFR Part 11 requirements. More information on the CFR compliance
features of the software is detailed in the Help.

Starting the SpectrAA software

To start the SpectrAA software click Start > Programs > SpectrAA.
Alternatively, double-click on the desktop SpectrAA icon (created
during the installation of the software).
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SpectrAA windows

Index page

When you start the SpectrAA software, the first screen to appear is
the introductory screen.

The Index page contains four buttons: Worksheet, Reports,
Administration, and Exit.

The function of each button is as follows:

Worksheet Opens the Worksheet window (see Page 70)
Reports Opens the Reports window (see Page 72)
Administration Opens the Administration window (see Page 73)
Exit Shuts down the SpectrAA software.

Worksheet window

The Worksheet window allows you to develop and edit methods,
sequences and labels, and initiate sample analysis.

The worksheet is the fundamental file type for SpectrAA, containing
one or more methods, sample labels, sequence information, and
analytical results. You can load an existing worksheet or develop a
new one.

The Worksheet window consists of four tabbed pages: Filing,
Develop, Labels, and Analysis. To access a particular page, click on
the appropriate page tab appearing under the menu bar.

The Filing page

Use the Filing page to perform basic worksheet operations such as
opening, saving, and closing worksheets, creating a template from a
worksheet, and loading worksheets. You can also view information
about the worksheet currently open. If you have the CFR version of
the software, the Filing page enables you to apply electronic
signatures (approval) to the worksheet.
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The Develop page

Use the Develop page to add, delete, review and modify methods,
modify sequence parameters, change the order of methods and copy
methods to the Method Library.

The Labels page

Use the Labels page to set up solution labels, weights, volumes, and
dilution factors and to configure SPS or PSD samplers.

The Analysis page

Use the Analysis page to control the AA and initiate analysis. Data is
presented in the form of a spreadsheet, with one row per sample. The
sample labels are displayed in the left-hand column with
concentration results for each element across the remaining columns.

The SpectrAA software enables you to have up to a maximum of 10
worksheets open at the same time. The Worksheet tab at the bottom
of the Analysis page enables you to switch between worksheets.

Worksheet menus

When you are viewing the worksheet, the following menu items are

available:
File This menu allows you to perform filing tasks such as opening, saving
and renaming files.
Edit The Edit menu allows you to copy and paste information, Edit
Replicates and Go To certain parts of a worksheet.
View The View menu enables you to nominate what is displayed on the

Analysis page.

Instrument  This menu enables you to perform many Instrument functions such as
Optimization, Reslope, and Zero.

Options The Options menu enables you to alter the displays on the Analysis
page.

Window This menu enables you to quickly move around the software.

Help This menu enables you to access the Help.
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Not all menu items are available on all pages of the Worksheet window. If an
item or menu is grayed, it is unavailable on that page.

72

Menu items can be accessed by clicking the desired item with the
mouse, or pressing Alt and the active (underlined) letter in the menu
name (for example, Alt+E to access the “Edit” menu). This displays a
menu list. The options in the menu list can be accessed in the same
manner.

Reports window

The Reports window allows you to generate a report for the current
worksheet or any of the worksheets saved in the system.

The Reports window consists of four tabbed pages: Worksheet,
Select, Settings, and Report. To select a particular page, click on the
appropriate page tab appearing under the menu bar.

Worksheet page

Use the Worksheet page to select the worksheet results to include in
the report. You can use the “Filter” and “Search” buttons to refine
your search.

Select page

Use the Select page to choose methods and solutions to include in the
report.

Settings page

Use the Settings page to specify the report style and content.

Report page

Use the Report page to view and print the report, write it to a text
file, or export it to a PRN file.
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Administration window

The Administration window allows you to: migrate worksheets into
the system (such as old worksheets on CD-ROM, etc.); delete
worksheets and library methods; and activate and modify password
protection of the system. The Administration window also allows you
to configure your system.

Working with the SpectrAA software

Menu bar

The Worksheet window contains a menu bar directly beneath the
window title bar. This bar displays several menu items. For more
information on these menus, see Page 71.

When menu items or options appear grayed, they are unavailable for selection.

Toolbar

The Toolbar appears on the Index page and the Worksheet window
and provides easy shortcuts to many common functions and other
windows.

Dialog boxes

In some cases, selecting a menu option or pressing a button activates
a dialog box. This is a box that contains several different input fields
relevant to that operation.

You can move the focus from field to field in a dialog box either by
clicking each entry item with the mouse or by pressing the Tab and
arrow keys to move the cursor from field to field. After
entering/changing any values in a dialog box, press “OK” to accept
the changes and close the dialog.
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Help

The SpectrAA software contains extensive Help, which serves as your
primary source of information on how to use the software and the
instrument. The Help consists of contextual help and multimedia
help. The Help also contains an extensive ‘How To...” section. This
section provides many set by set instructions on how to perform
common procedures.

The contextual help is accessed from any window, page, or dialog box
in the SpectrAA software by pressing F1 (the Help function key), the
‘Help’ button (where available), or by selecting ‘On-line Help’ from
the Help menu at the top of any page in the Worksheet window, and
provides help specific to that screen.

The multimedia help contains hardware-related information and
other details to help you set up, operate and maintain your Agilent
AA instrument.

For example, the Help includes:

¢ Installation procedures for the components of the instrument
that are customer-installable

e Maintenance procedures for the parts of the spectrometer that
are customer-serviceable

¢ CheckKlists to help you ensure that you have correctly prepared
your system for analysis.

To view the video clips included in the online help you must have the SpectrAA
CD inserted in the CD-ROM drive. Alternatively, you can copy the video files from
the Help CD into the \\run\help subdirectory within the directory where the
SpectrAA software is loaded.

74

Agilent 240/280 Series AA User’'s Guide



Software Overview

Searching for help

You can quickly get help on a specific topic using keywords and the
Search facility.

To search for information on a particular subject:
1 Open the Help (if it is not already open).
2 Select the Search tab at the top of the SpectrAA Help window.

3 Enter the word(s) you want to search for in the field provided
and select List Topics.

4 A list of all the Help topics associated with the keyword(s)
displays in the second list.

5 Select the desired topic and click Display.

Printing help
To obtain a printed copy of the current Help topic:

1 Select the Print icon at the top of the SpectrAA Help window.

2 From the Print Topics dialog, select whether you want to print
the selected topic or a range of topics and then select OK.

The topics you selected are printed on the nominated printer.

Information presented in a popup window cannot be printed.

Viewing help while you work

If the Help window obscures the application you are working in, you
may want to resize the Help window or move it so that you can view
both the Help window and your application window at the same
time. This is useful if you are using Help to follow a step-by-step
software procedure.

Quitting help

To close the SpectrAA Help window, select the “X” on the top right
corner of the Help window or press Alt+F4 to close the window.
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This chapter describes how to set up the Agilent AA system for
analysis and get you started using the instrument.

You should have already:

e Prepared your PC and installed the SpectrAA software as
described in Chapter 3.

¢ Become familiar with the SpectrAA user interface as described in
Chapter 4.

Instrument setup

Use the following checklist to ensure that you set up your system
correctly. You must:

¢ Connect the components of the system to one another (see
‘Connections’ on Page 78).

¢ Connect the equipment to the power supply, and check the
setting of the two voltage taps where fitted (see ‘Power’ on Page
78).

e Install the hardware components as per your analytical
requirements. Refer to the Help for details.
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Connections

Your Agilent AA instrument is supplied with a set of gas hose fittings
and a mains cable that suits the common utility standard in the local
region. A Country Kit must be ordered with the Agilent AA
instrument.

Power

The mains power connection is located at the rear of the instrument.
Refer to the next section for instructions on connecting the
instrument to the mains power supply.

Gas hoses

Three rubber hoses are permanently attached to the instrument.
Each hose is 1.8 meters long and is color-coded for air (black),
nitrous oxide (blue), and acetylene (red). Each is fitted with female
fittings suitable for USA standard regulators. Adaptors are supplied
for other areas.

Gas hose connections are not detailed in this section as they are described in
your Agilent AA Site Preparation Guide.

78

Accessories

For details on connecting accessories such as SIPS or UltrAA lamps,
refer to the manuals accompanying the accessories.

Power

Requirements

Power requirements are detailed in your Agilent AA Site Preparation
Guide, and also in the ‘Specifications’ section in Chapter 1 of this
manual. Check the power requirements and read through the section
‘Electrical power supplies’ in the Site Preparation Guide before
connecting the Agilent AA system to the power supply.

Consult the manuals supplied with your printer and PC (if required)
for their power requirements.
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Connection

Before connecting the instrument to the power supply, ensure that
both the spectrometer and the mains power supply are turned off.
Check that the two voltage selector switches on the instrument rear
panel (if present) are set to the correct mains power supply voltage—
refer to the table on the rear panel. The Agilent field service engineer
sets the voltage selectors when the instrument is first installed.

To connect the instrument to the power supply, plug the mains
power cord into the back of the instrument and the free end of the
power cord into the mains power supply, and then switch on the
mains power supply.

Moving your instrument

m Heavy Weight

The instrument weighs over 50 kg (110 Ib). Do not attempt to lift the

instrument alone. Always use two or more people when lifting or carrying the
instrument into position.

Starting the system

The instrument power switch is a rocker type, located on the front of
the instrument on the left-hand side. Switch the power switch to ‘I’ to
start the system. The green indicator light will come on.

For instructions on how to start any accessories, refer to the manuals
supplied with the accessories.

If you have not already done so, start the SpectrAA software as
described on Page 69.
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Pre-analysis checklist

The general preparation procedure is as follows:

1 Install all the required hardware, including any associated
accessories such as SIPS, according to the instructions in the
Help (see Page 74) and any accessory manuals.

2 Turn on the instrument and any peripheral accessories as
described in the previous section.

3 Hold a thin single-ply tissue up to the mouth of the extraction
hood to ensure that the exhaust system is working. The tissue
should be drawn towards the hood.

4 Check the gas supplies to make sure that you have enough gas to
complete your analysis. Also, check that the acetylene cylinder
pressure is above 700 kPa (about 100 psi) to ensure that acetone
is not drawn into the instrument.

5 Set the delivery pressure of the gases to the following:

Recommended Permissible
kPa psi kPa psi
Acetylene 75 1" 65-100 9.5-14.5
Air 350 50 245-455 35-65
Nitrous oxide 350 50 245-455 35-65

6 Inspect the gas hoses for damage, replacing any damaged hoses.
Turn on the gas supplies to your instrument and test all hoses
and connections for leaks. If a leak is found, repair it
immediately.

7 Load a worksheet and develop the method(s) as per your
analytical requirements.

8 Optimize the system.

Start an Autorun.

Detailed procedural help for Steps 7 to 9 are provided in the Help. See Page 74
for details of how to find information in the Help.
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The following is a list of maintenance procedures that must be
performed to keep your instrument running safely and with optimum
performance. See the ‘Maintenance’ section in the SpectrAA Help for
replacing and cleaning procedures.

To access the Help click Start > All Programs > SpectrAA > SpectrAA
Help or, with the SpectrAA software, open press F1 on your
keyboard.

Do not perform any procedures not listed in this manual or in the
SpectrAA Help. Contact your Agilent representative if further
information is needed.

The procedures listed below may involve hazardous chemicals and
fumes, hot surfaces, and handling fragile lamps and glass. Always
follow the correct procedure listed in the SpectrAA Help, adhere to
all safety and chemical disposal regulations, and wear the
appropriate safety equipment.

m Corrosive liquid

The contents of the liquid trap may be toxic or corrosive. Dispose of the

contents in accordance with approved procedures and always wear the
appropriate safety equipment.
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m Hot surfaces

Some components within the spectrometer may remain hot after turning off
the instrument. Before performing any maintenance procedures always allow
the components to cool.

82

Sharp objects

Great care should be taken when working with glass or quartz parts to
prevent breakage and cuts.

Schedule

Daily

Check that the exhaust system has positive extraction
Check the gas supplies

Check all hoses and connections for damage, leaks and wear
Empty the drain vessel

Clean the instrument

Clean the burner (Flame systems only)

Rinse out the spray chamber and liquid trap (Flame systems
only)

Check graphite components including the shroud, electrode, and
tube (Furnace/Zeeman systems only)

Clean the electrodes (Furnace/Zeeman systems only)

Replace the tube if necessary (Furnace/Zeeman systems only)
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Weekly

e Check for o-ring deterioration:

Three o-rings inside the burner, spray chamber, and the bung
(see Figure 4)

Two o-rings that seal the gas inlets to the spray chamber (see
Figure 5)

Always ensure the sealing surfaces are clean and free of debris before re-
inserting the component.

1
€.
- b
\ 2
&
LN

Figure 4. Disassembled spray chamber and Figure 5. Spray chamber removed from gas
burner where: inlet where:
1. O-ring on burner assembly 1. 0-rings (x2) that seal the gas inlets to the spray
2. 0-ring inside the spray chamber chamber

3. 0-ring inside the bung
¢ (Clean the lamp and sample compartment windows
¢  Check the air compressor filter
e Check the water levels in recirculating supplies
(Furnace/Zeeman systems only)
Yearly

Arrange for an Agilent service engineer to perform preventative
maintenance.
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Cleaning

84

Instrument surfaces

Clean contamination immediately using the approved laboratory
procedures.

If there is contamination inside the instrument immediately turn off
the instrument and call your Agilent representative.

1 Switch off the instrument and allow it to cool.

2 Remove any hardware present in the sample compartment (refer
to the appropriate instructions in this User’s Guide and the
SpectrAA Help if necessary).

3 Using a cloth dampened with water, clean the sample
compartment, instrument cover, and chimney. On Flame systems,
also clean the front panel and flame shield. If necessary, use a
mild detergent to clean the cover. Do NOT use an abrasive
cleaner. When analyzing biological samples, wipe the instrument
with chlorhexidine in 95% ethanol.

Windows

Clean the sample compartment windows and the lamp compartment
window with a gentle stream of filtered air, or a puffer brush, like
those used to clean camera lenses.

If the windows are dirty, wipe them using an optical tissue held
between tweezers and dampened with a 50% ethanol/water solution.
Filters

Check the filter in the air compressor supply line and clean if
necessary (instructions are included with the filter.)
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Gas cylinders

Change gas cylinders according to the instructions supplied by the
manufacturer.

When changing gas cylinders:

¢ Inspect all gas supply pipes and hoses. Replace any hose showing
signs of damage or deterioration.

e Test all connections for leaks using a commercial leak testing
solution, a mild dish washing soap solution, or an electronic leak
detector.

¢ Test the operation of all regulators.

¢ Ensure that shut off valves are correctly functioning.

Preventing flashbacks

Instrument and consumable maintenance is important to prevent
flashbacks or unexpected flame events. See the Safety section on
Page 26 for detailed information on how to prevent flashbacks.

In the event of a flashback or unexpected flame event
e Immediately press the red flame-off button to turn off gas flows
to the instrument
e  Turn off the gas supply
e Turn off power to the instrument

¢ Inspect the sample introduction components including the
burner, spray chamber, and nebulizer and clean or replace as
necessary

Check burner condition and O-rings for damage

Check O-rings for the spray chamber, especially the pressure
relief bung for damage

Check the nebulizer for damage

Check the windows on either side of the flame area for
damage
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e (Clean up any spills in the sample introduction area or on the
instrument

e Review the ‘Safety’ section on Page 26 or the SpectrAA Help
‘Safety’ section for detailed information on how to prevent
flashbacks.

Contact your Agilent representative if additional information is
needed.

Spare parts
See the Agilent website for ordering information.

Use only Agilent-supplied or approved spare parts with your
instrument.

http://www.chem.agilent.com/en-US/products-services/Parts-
Supplies/Spectroscopy/Atomic-Absorption/Pages/default.aspx
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